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 You will see a small window with title "Lunching Application" downloading InnovBase new updates from Internet. 

 So you can accept or refuse the updates  

 
 

 

 
 

Running InnovBase 

 You can run InnovBase by double-click on InnovBase shortcut on your desktop - InnovBase® checks for updates whenever you lunch it. 
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Application Registration:  
 

 After successfully launch the InnovBase®, the following 

Login Screen will appear: 

 

 Press on Details Button to Expand Application 

Registration Options: 

 
 
 
 
 
 
 
 
 

 SQL server: select your SQL server from the dropdown 

list. 
 

 Authentication: InnovBase has three login options; select 

your authentication as follows: 
 

  Windows Authentication: To login using your Windows 

User Account. 
 

 SQL Server Authentication: To login using SQL Server 

User Account (User Name & Password are required). 

 

 Programming Mode   (Golden & Platinum Edition Only): a 

special login for development purposes.  
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For Better use, some tabs are shown only when needed. For example, the File tab is shown only when an Object is selected. 

The menus and toolbars in InnovBase 2010 have been replaced with the Ribbon. 

 InnovBase 2010 have been designed this Ribbon to help you quickly find the commands that you need to complete a task. Commands are organized in logical groups, which 

are collected together under tabs. Each tab relates to a type of activity, such as edit, new or managing.  
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Let’s find out other widgets: 

 Next to "Tool Bar" you can see "System Explore" on the left side, and work area on the right with its gray colure. 

 Try to catch system explorer menu and move it to another place, or let it stable by moving it to the border area 

 

 New: for new object \record\file whatever it is ex. Employee or Action Sheet etc... ,  

 Open: open an existing file,  

 Reports: open related reports for the selected object, you will see Save and Delete active when you open an existing file to modify it or delete it. 
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 At the bottom   "Status Bar" will be displayed with application name, user information, and authentication mood, also number of tags and connection status 

and the word "Ready" which means that you can now begin your work in InnovBase.  

 

 
 
Let’s do an example: 

 Start to expand system explorer items and select an object, for example select Person then press on New button exists in Ribbon 
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 Now do your works in the displayed object or document then save your work by pressing “Apply” then “Save" button. 

 Message box will appear asking for confirmation to save, press OK to complete save process. 

 Note: You can put OK sign in the small chick box in the corner of "Save" button before pressing "Save" to save your work and open another new window 

again. 
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 Open: When you press this command, "Search" window will appear, so you can chose the field you are going to search according to. Write first letters of the word you are 

looking for and press ENTER. InnovBase will list all records which began, contain or end with letters you wrote according to search type radio button you have selected in the top 

of the window (left, center and right), or check Key Press option to find match wile typing 
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 Always you can put OK sign in the small chick box in the corner of any button has this chick box to close the displayed window and again open it for new use.  

 When you double-click on a search result, InnovBase will open the record or document you have selected from the list. So you can modify the information or keep it as it is. 

 

Wildcard 
character  

Description  Example  

% Any string of zero or more characters. WHERE title LIKE '%computer%' finds all book titles with the word 'computer' anywhere in the book title. 

_ (underscore) Any single character. WHERE au_fname LIKE '_ean' finds all four-letter first names that end with ean (Dean, Sean, and so on). 

[ ] 
Any single character within the specified range ([a-

f]) or set ([abcdef]). 

WHERE au_lname LIKE '[C-P]arsen' finds author last names ending with arsen and starting with any single character 

between C and P, for example Carsen, Larsen, Karsen, and so on. 

[ ]̂ 
Any single character not within the specified range 
([^a-f]) or set ([^abcdef]). 

WHERE au_lname LIKE 'de[^l]%' all author last names starting with de and where the following letter is not l.  

 If you are going to search according to specified field repeatly, you can add that field to "Favorites" by selecting the field and pressing the button "Add to Favorites". 

InnovBase will ask for name to that field, so you can name the field as you wish or keep its name as it is. 

 "Remove from Favorites" button will be used to remove favorite fields which you are no longer interested in searching according to. 

 You can print you search results by using "Print" button 

 You can use % and other characters as wildcard characters as follows: 
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 Save: After modifying displayed record or document –like in the previous menu command- you can use this menu command to save your data. 

 Reports: You can have some reports about the information you have by using this command 
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Edit Tab: 

 Copy: To have a copy of selected text in Windows Clipboard, then you can use Paste command. 

 Paste: To paste cut or copied text from Windows Clipboard to selected place. 

 Undo: To cancel last changes you have done. 

 Redo: To cancel last Undo command you have executed. 

 Cut: To move selected text to Windows Clipboard, then you can use Paste command. 

 Select All: To select the whole text in cursor position, then you can use Cut, Copy, Delete or even Paste replacing selected text. 
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My Account Tab: 

 Forward Approvals: to open forward approvals window 

 Preferences: when you press the command, Preferences window will appear with four tabs  
 Defaults: Where you can select InnovBase language and what InnovBase will do when you double click on an item in System Explorer or one of functional keys in your         
keyboard F1 to F12 also what you want to show in System Explorer tree. 
 

 Fonts: where you can change fields' font and its color, also captions' font and its color 
 
 Colors: InnovBase helps users to do their work easily, so it adopted a coloring system, and here you can customize it.  

You can choose colors of mandatory and optional fields and Expressions. 
Also you can choose the color which will color your windows while it is new or under modifying (editing) or when it is for read only. 
 

 Help Assistant: where you can choose Help Assistant Character. 
 
 Text Capture features. You can configure InnovBase to capture any employee ID … etc… from any application such as Outlook and Word to display his details 

information such as the following sample: 
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 I have receive the following msg. which contain a request to Check In our employee 

 I have just use {Ctrl} + {Shift} to highlight the employee ID to retrieve the information direct from our ERP as follows: 
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 Text Capture Configuration: 

 Click on Preferences button then choose Help Assistant Tab then select Text Capture Object and Text Capture Field.  

 Note: you should install this application first   http://www.renovation-software.com/en/text-grab-sdk/textgrab-sdk.html 

 

http://www.renovation-software.com/en/text-grab-sdk/textgrab-sdk.html
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 Change Password: You can easily change your password, just select this command and enter your old password then the new one and confirm again then press OK, Login 

window will appear so you have to re-login or InnovBase will close.  
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View Tab:  

 System Explorer: To hide/show System Explorer, so you will have bigger area for your windows inside InnovBase. 
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 Reminders Window: To display reminders items in an independent list 
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 Attachments: If you want to attach any kind of files to a document, simply use this command, For example open an existing document\file and press on attachment button 

 Attachment Grid (table) will appear at the bottom of Work Area. You can use Open button to add the attachment you want through Open Window which will appear 

Anytime you want to view the attachment(s), simply choose this command again and press View button in the grid to have the at tachment opened in the proper associated 
program.  
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 Approvals: InnovBase has comprehensive work flow system 

 Administrators and Managers can approve or reject entered and changed information. All what they need is to use the button Approval in View Tab to approve or reject 

changes, or reply the email which receive in their Email Inbox approving or rejecting. 

  
 
 

 
 



 

 
22 

 
 

 
 
 

 Approval Status: users or administrators can view approval status by clicking Approval Status button in View Tab, so Approvals window will appear at the bottom of Work 

Area. 
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 Drill Down: After showing a document from search results, you can drill down according any field in your document, just click on Drill Down button exist in View Tab to show 

Drill Down window then click on the caption of the field you want to drill down. See example below to drilldown persons whom last name Ali. 

 When Drill Down window is displayed, choose any record by double click to open, so you can easily have more and more information. Also you can filter your drill down by 

selecting the filter you want from top right corner in Drill Down window. 
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 Drilldown persons who have first name TARIQ and last name ALI 
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 Windows: Like any another Windows application, InnovBase environment allow you to Cascade, Tile Vertical, Tile Horizontal, Close All, Arrange Icons or select one of opened 

forms. 
 
 

 

 Skins: change interface color  
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 System Tab: 

Configurations: When you select this command Configuration window will appear containing four tabs 

 
 

 General: Where you can choose a name for your application, and write your company name and its address. 
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 Email: Where you can enter your email settings like SMTP user name and password, Ports and the interval between two email checks. 
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 Library: Where you can set path for Dictionary which you can use for translating forms, and also set path for your Library. 
 Application Intelligence: for more details see Developer Guide. 
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 Groups and Users: Shows Groups and Users window 
 
 

 

 Groups In this window you can see 

Groups and Users in each group, also you 
can use buttons on the right side to  

 Create New Group: Here another 
window will appear to define a name 
and privileges to the created group 

 Change Group Properties: Where 
you can edit privileges of the selected 
group. Remember that you can use 

Grant All button to grant all privileges 
to a group or Revoke All button to 
revoke all privileges from a group. 
 Delete Group: To delete the selected 

group and users who belong to. 
Confirmation message will ask for OK 
before deleting. 
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 Add New User: Here another window will appear with three tabs: 
 User: Define user name, password, Email for sending approvals, and group. 
  Permissions: Define which permissions will be given to the user. Remember that you can use Grant All button to grant all Permissions to him, Revoke All button to 

revoke all permissions from him, or Set Default Permissions to grant him default group's permissions 
 Options: Here you can force user to change his password after specified number of days, or to prevent him to login in specified date or from specified computer. 
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 Help: From this menu you can show Help Assistant and reach Help topics. 

 About InnovBase: to have information about your version of InnovBase. 

 

 


